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Both general and per project settings are considered. Description Init steps Yes Executes the init steps defined in the MCU settings Erase sectors Yes Performs an erase depending on the settings, selected in the drop down box. Therefore, the J-Link Software and Documentation Pack already includes some example projects for various special setups
which can be used as reference for custom setups. Write File 8bit Address (Hex) Data (Hex) Writes 8bit data to a given address in the data file. Increasing log levels result in more information logged in the log window. Another notable feature is smart read back, which only transfers non-blank portions of the flash, increasing the speed of read back
greatly. Smart read back: only non-blank portions of flash are transferred and saved. Some options accept additional parameters which are enclosed in angle brackets, e.g. . Manual Programming > Erase Sectors Erases all selected flash sectors. Global settings... -exit Exits J-Flash. This works fine for ARM only scan chains. In case a serial number list
file is given, Next SN describes the line of the serial number list file where to read the next serial number bytes from. Remedy: First of all, make sure the target is actually connected to J-Link. The J-Link / J-Trace User Guide (UM08001) is part of the J-Link Software and Documentation Pack which is available for download under segger.com/jlink-
software.html. To use these chips the user must first perform the required initialization. The Exit steps can be used to do some special handling after programming, for example to set some security bits in order to secure the chip. The serial number list file needs to be created manually by the user and has the following syntax: One serial number per
line Each byte of the serial number is described by two hexadecimal digits. Serial number is 1-4 bytes in size. In the following, some generic information how to setup a serial number programming configuration are given. The following chapter introduces J-Flash, highlights some of its features, and lists its requirements on host and target systems. A
return value unequal 0 means that an error occurred. Check core ID If the core ID is known for the device to be programmed, it can be used to verify that the device in communication with the J-Link / Flasher is the intended device. Supported microcontrollers J-Flash supports download into the internal flash of a large number of microcontrollers. It is
recommended to always use -openprj -open[,] to make sure the right project file and the right data file is opened. The hostname (or IP address) of the system to connect to be may be entered in the textbox for TCP/IP. ID checking There are two other checkboxes that are of interest in this subsection which are Check manufacturer flash Id and Check
product flash Id. These checkboxes should be selected to confirm the type of device that is in communication with J-Flash. If the NOR flash device which is used is not CFI-compliant, the flash device has to explicitly selected in J-Flash. General Settings This dialog is used to configure the connection to the J-Link / Flasher. Please refer to Project
Settings. All command line options return 0 if the processing was successfully. Disable Checks -- -- Disables JTAG checks. JTAG scan chain The “JTAG scan chain information” box allows to configure a JTAG scan chain with multiple devices on it. Note: This check takes place for Target -> Production Programming as well as Target -> Manual
Programming. If the area to erase is already blank, no erase happens. This dialog allows the user to enter a custom initialization sequence using a predefined list of operations. Auto-update of project When opening a J-Flash project with a version of J-Flash that is more recent than the version of J-Flash that the project was last saved with, it can
happen that J-Flash prompts the user to allow an automatic update of the J-Flash project contents. For more information on how to create a custom RAM Code for J-Flash, please refer to the article: Creating a Flash Loader For more information about which which microcontrollers with internal flash are supported by J-Flash, please refer to Supported
microcontrollers . Test > Hardware > Activate BUSY Sets the RS232 Busy signal of a connected Flasher. In this case, please provide us with the following information: A detailed description of the problem. Next SN In case no serial number list file is given, Next SN is the next serial number which should be programmed. If the number of bytes
specified in a line of the serial number list file is greater than the serial number length defined in the J-Flash project, the remaining bytes will be ignored by J-Flash. USB S/N If this option is checked, J-Flash will connect to J-Link / Flasher over the USB port. -merge-merge.bin, Merges a given data file with the one currently opened in J-Flash. The
screenshot below shows the command line help dialog, which is displayed if J-Flash is started with the command line parameter -help or -?: JFlash.exe -help JFlash.exe -? If 8 is selected as length, the serial number and its complementary is programmed at the given address. Contacting support If you experience a J-Flash related problem and the



advices from the sections above do not help you to solve it, you may contact our J-Flash support. Please make sure that the used project file is located at a folder with write permission. -readrange, Reads specified range of target memory. -saveprj Saves the current project. The steps implemented in J-Flash: MCU settings: Init Steps: Example Serial
number programming J-Flash supports programming of serial numbers. The example batchfile below will cause J-Flash to perform the following operations: Open project C:\Projects\Default.jflash Open bin file C:\Data\data.bin and set start address to 0x100000 Perform “Auto” operation (“Production Programming”) Close J-Flash The return value will
be checked and in case of an error an error message displayed. echo Starting J-Flash... Free evaluation licenses available. Remedy: Using smaller RAM block sizes may fix this problem. Remedy: Ensure the specified core ID is correct for the used target CPU. Other Flasher models will use VCC5V, even when VTGT is selected. start "" 9>"!lock!1"
StartJFlash.bat 164000000 Path\To\Project.jflash Path\To\DataFile.hex start "" 9>"!lock!2" Start]JFlash.bat 164000001 Path\To\Project.jflash Path\To\DataFile.hex start "" 9>"!lock!3" StartJFlash.bat 164000002 Path\To\Project.jflash Path\To\DataFile.hex REM Wait for processes to finish before continuing for %%N in (1 2 3) do ( call :WaitForUnlock
lock!%%N ) 2>nul REM Delete temporary lock files del "!lock!*" echo Done. High speed programming: up to 550 KBytes/s*. Command Description Open data file... In the following sample, 4-byte serial numbers starting at 1234567 (0x12D68) shall be programmed at address 0x08001000. \ETC\JFlash Two *.csv files for the J-Flash internal
management of supported MCU’s und flash chips. Remedy: Make sure a correct RAM address is specified in the project settings. Set the PLL by writing to power management controller. Verify 8bit Address (Hex) Data (Hex) Verifies whether 8bit data on a declared address is identical to the declared 8bit data. The following steps are taken into
consideration when calculating this CRC: The CRC is calculated over all sectors which are selected in the current project Everything that is not covered by the data file (gaps in the data file, unused sectors etc.) which is opened, is assumed as OxFF during the CRC calculation. For serial NOR flash, NAND flash and DataFlash devices a custom
RAMCode is needed since the connection of the flash to the CPU differs from device to device. Flash Settings: external Flash If a specific device has been selected to program the flash of these device, the menu should look similar to the screenshot below. This sample can be used as a template to be adapted according to the requirements of your
project. Does nothing. For a list of all parallel NOR flash devices which can be explicitly selected in J-Flash, please refer to Supported Flash Devices. SetAllowRemoteWrite -- On/Off This option defines if the emulator (remote) or the host handles the write access to the target. If you need support for a chip or flash not listed in the tables, please do not
hesitate to contact us. Var Write 32bit Address (Hex) Data (Hex) Writes 32bit data of the internal variable to a given address. Read 8bit Address (Hex) -- Reads 8bit from a given address and stores the value in the internal variable. Supported Operating Systems The following operating systems are supported: Microsoft Windows 2000 Microsoft
Windows XP Microsoft Windows XP x64 Microsoft Windows 2003 Microsoft Windows 2003 x64 Microsoft Windows Vista Microsoft Windows Vista x64 Microsoft Windows 7 Microsoft Windows 7 x64 Microsoft Windows 8 Microsoft Windows 8 x64 Microsoft Windows 10 Microsoft Windows 10 x64 Linux (Requirements) macOS 10.5 and higher Features
Any ARM7/ARM9/ARM11, Cortex-M0/M1/M3/M4/M7, Cortex-A5/A8/A9/R4/R5 and Renesas RX600 core supported Microcontroller (internal flash) support. Intuitive user interface. Var AND -- Value (Hex) Logical AND combination of the internal variable with a given value. Serial number file When starting the program process Target -> Production
Programming, J-Flash will create a serial number file named as Serial.txt . If only a core family is selected, the core ID field can be modified. When that is that case, the message box shown below will appear.As long as the project file format has not changed from one version to another, the project file should open in both versions without any issues.
Flash Settings: internal Flash Base Address This is the base address of the flash. Further information regarding this can be found here: CRC of current data file When opening a data file in J-Flash (File -> Open...), J-Flash calculates and displays the CRC of the user data in this file. Verify the correctness of the init sequence, check the JTAG speed, and
ensure the correct flash type is selected. TCP/IP If this option is checked, J-Flash will connect to J-Link / Flasher via TCP/IP. About... If you feel that your knowledge of J-Link is not sufficient, we recommend the J-Link Manual (UM08001), which describes the device and its use in detail. Test > Show CFI info Reads the CFI query information of a CFI
compliant flash device. Write 32bit Address (Hex) Data (Hex) Writes 32bit data to a given address. Var BNE Index -- Checks if the internal variable is not equal to 0. This means that an compatible init sequence for the microcontroller must be built, if a new project is created or an existing project is modified. For more information about how to use
multiple J-Link / Flasher on one PC, please see also the chapter “Working with J-Link” of the J-Link Manual (UM08001). Download serial number file to Flasher Downloads a serial number file to a connected Flasher. The data file must be one of the following: Intel HEX file, Motorola S file, Binary file or ELF file (.hex, .mot, .srec, .bin or .elf). Save data
file Saves the data file that currently has focus. -ip-ip Overrides connection settings to IP. The organization settings make it possible to configure the bus width and the number of flash chips connected to the address and data bus of the MCU. External Flash specific settings Flash Settings: external Flash, auto detection unchecked Organization For
some flashes (e.g. CFI compliant NOR flashes), the organization needs to be specified. -openprj Opens an existing project file. Exit steps Those steps will be performed immediately after the target has been successfully programmed. Relocates the start of the data file to the supplied hex offset from the current start location. Using J-Flash for the first
time Welcome dialog When starting J-Flash, by default a startup dialog pops up which gives the user two options how to proceed. Command Description J-Flash User Guide Opens this document in the default .PDF application of the system. To program internal flash devices, the respective microcontroller must be selected in the Device list by clicking
the ... If command line options are provided, J-Flash will still start its GUI, but processing will start immediately. Opens the global settings dialog. Manual Programming > Check Blank Checks flash to see if it is empty. No matching RAMCode Meaning: There is no programming algorithm available for the selected target memory type. @ECHO OFF
ECHO Open a project and data file, start auto processing and exit JFlash.exe -openprjC:\Projects\Default.jflash -openC:\Data \data.bin,0x100000 -auto -exit IF ERRORLEVEL 1 goto ERROR goto END :ERROR ECHO ]J-Flash ARM: Error! pause :END Starting J-Flash minimized The following example call starts J-Flash minimized: start /min /wait "J-Flash"
"JFlash.exe" -openprjC:\Projects\Default.jflash - openC:\Data\data.bin,0x100000 -auto -exit Note: Every call of JFlash.exe has to be completed with the -exit option, otherwise the execution of the batch file stops and the following commands will not be processed. Test > Generate test data Generates data which can be used to test if the flash can be
programmed correctly. Start serial number, increment, serial number size and address have to be configured in the J-Flash project production settings. Show log Opens and/or sets the focus to the log window. If a serial number in the list file does not define all bytes of Len, the remaining bytes are filled with 0s. Opening a project will close any other
project currently open. Deletes a range of values from the data file, starting and ending at given addresses. For non-CFI compliant ones, J-Flash allows the user to explicitly select the device. New project Creates a new project (See Creating a new J-Flash project) Open project Opens a J-Flash project file. Make sure the flash memory is unlocked before
programming or erasing. Otherwise, select little endian or big endian from the dropdown menu accordant to the device. CRC: Verifies data via a high optimized CRC calculation (recommended verification method). For ARM cores, the IRLen is always four, which is why the value of IRLen is by default set to four times the position indicated. Remedy:
Inform us about the flash type you want to use. If no recently used project could be found, J-Flash generates a default project. The J-Flash application. When selecting Target -> Production Programming, J-Flash will check for a serial number list file named as SNList.txt in the directory where the J-Flash project is located. This is done by enabling the
Program serial number option as shown in the screenshot and table below: Program serial number option Setting Meaning Address The address the serial number should be programmed at. SetModeBigEndian -- -- Sets bit 7 of the CP15 register to 1. -delrange, Deletes data in the given range. Unexpected core ID Meaning: The specified CPU core ID
does not match with the one read from the target CPU. * Depending on flash device. .\Doc Contains the J-Flash documentation and the other J-Link related manuals. Unsupported flash type / bus width Meaning: The target flash memory or the bus organization is not yet supported. Increment Specifies how much Next SN is incremented. Those project
files can be found in the \Samples\JFlash\ProjectFiles sub directory of the J-Link Software and Documentation Pack installation directory. Save project Saves a J-Flash project file. After choosing an operation and corresponding values to be associated with the operation, a comment may be added to make it easier for others to determine its effect. -
unsecurechip Unsecures target device. If a microcontroller is not found on this list, contact SEGGER, as new microcontrollers are continuously being added. Command Description Project settings... -savecfg Saves emulator config file. Licenses... -jflashlog Sets a temporary J-Flash logfile. Verify Yes Verifies the program data. Set flash wait states by
writing to the MC Flash Mode Register. On "Verify" Configures the type of verify that takes place: Global Settings General log level This specifies the log level of J-Flash. If a core family has been selected in order to program external flash memory or a custom Flash Bank has been added and is selected, the menu should look similar to the screenshot
below. For more information on the J-Link Remote Server, please refer to: J-Link Remote Server overview USB If this option is checked, J-Flash will connect to J-Link / Flasher over the USB port. -checkblank Blank checks target. Save project file on close If this option is checked, J-Flash will always save the changes made to a project file when a project
or J-Flash is closed and therefore overrides the old project file without asking for permission to do so. -erasesectors Erases selected sectors. In this case Next SN needs to be set to 0, since programming should be started with the serial number bytes defined in the first line of the file. Verify 32bit Address (Hex) Data (Hex) Verifies whether 32bit data
on a declared address is identical to the declared 32bit data. Exit Exits the J-Flash application. Enable J-Link logfile If this option is checked, a file name of the J-Link logfile can be specified. An individual or series of sectors may be selected from the predetermined valid range. The listed options of the Flash settings menu are dependent on the
selection in the MCU Settings. Settings The following chapter provides an overview of the program settings. Saves a J-Flash project file using the name and location given. Default: Erases, programs and verifies target. This RAM is called work RAM. -readchip Reads the entire flash chip. J-Flash has an intuitive user interface and makes programming
flash devices convenient. By default, J-Flash uses the “Auto” CPU speed detection feature. Setup The J-Link setup procedure required in order to work with J-Flash is described in chapter 2 of the J-Link / J-Trace User Guide (UM08001). Write File 16bit Address (Hex) Data (Hex) Writes 16bit data to a given address in the data file. -saveprjas Saves the
current project in the specified file. Init Steps: Add action dialog In the Action Type dropdown menu all available actions are listed. The latest list of supported flash devices can always be found on our website: List of supported flash devices Performance For programming speed measurements, please refer to the SEGGER website: Internal Flash
programming performance Background information This chapter provides some background information about specific parts of the J-Flash software. J-Link User Guide Opens the J-Link Manual (UM08001) in the default .PDF application of the system. It should be programmed as follows in the memory: 0x08000000: 0x01 0x02 0x03 0x04 0x55 0x66
0x77 0x88 The serial number list file should look as follows: 0102030455667788 The number of bytes to read per line is configured via the Len option in J-Flash. Test > Hardware > Deactivate OK Resets the RS232 OK signal of a connected Flasher. The following example is excerpted from the J-Flash project for the AT91SAM7S256. Which line J-Flash
will read at the next programming cycle is configured via the Next SN option. Notes: If the number of bytes specified in a line of the serial number list file is less than the serial number length defined in the project, the remaining bytes are filled with Os by Flasher ARM. The command line interface allows using J-Flash in batch processing mode and
other advanced uses. Report Error Value (Hex) -- Displays a message box in J-Flash with the given error code. The startup dialog provides the following options: Open existing project: Select a project from the list of recent projects or press Other... to open another existing project. Write&Verify 32bit Address (Hex) Data (Hex) Writes 32bit data to a
given address and verifies it afterwards. For an overview which SEGGER products come with a built-in license for J-Flash, please refer to the J-Link Model overview. If only a core is selected, the target endianness must be specified as well. The data file can changed in the init steps by using the "Write File*" commands. Example init sequence A good
example of a typical init sequence is the init sequence of an AT91SAM7 CPU. -hide Starts J-Flash hidden. All important options are available in command line mode as well. Var OR -- Value (Hex) Logical OR combination of the internal variable with a given value. Verbose logging of all communication. Needs reset pin to be connected to Flasher. pause
exit /b REM REM :WaitForUnlock REM REM Function description REM This function waits for the passed lock file to be accessible REM REM Parameters REM %~1 Lock file path REM :WaitForUnlock :Retry REM This is a ping to the IPv6 local loopback address which is used to burn some time waiting for J-Flash to finish 1>nul 2>nul ping /n 3 ::1
call 9>"%~1" || goto Retry exit /b Start]Flash.bat: @ECHO OFF REM REM Expected parameters passed to this script: REM %1 S/N of USB Flasher REM %2 Path to project file REM %3 Path to data file REM REM Open a project with a data file, start programming and exit afterwards REM start /wait "J-Flash" "JFlash.exe" -usb%1 -openprj%?2 -open%3
-auto -exit IF ERRORLEVEL 1 goto ERROR goto END :ERROR ECHO %ERRORLEVEL% ECHO ]J-Flash: Error! SN: %1 pause exit :END ECHO ]J-Flash: Succeed! exit Device specifics For some devices, special handling might be required. The position of the device to connect with J-Flash is selected from the Position dropdown menu. For more
information about the different types of interface speed please see the chapter “Setup” of the J-Link Manual (UM08001). Start application No Starts application after programming/verify completed. Also, note that a parameter must follow immediately after the option, e.g. JFlash.exe - openprjC:\Projects\Default.jflash. Start line into serial number list
file to get next serial number bytes, line increment, serial number size and address is configured in J-Flash production project settings. J-Flash is not always forward compatible. The following list shows all valid commands which can be used in an init sequence: Command ValueO Valuel Description Delay -- Length of the delay Sets a delay. -usb
Overrides connection settings to USB S/N. Var Write File 32bit Address (Hex) -- Writes 32bit data of the internal variable to a given address in the data file. Manual Programming > Start Application Starts the application. Var BEQ Index -- Checks if the internal variable is equal to 0. Sectors if not blank: Erases all sectors which are both, effected by
the image to be programmed and not already blank Chip: Erase the entire chip independent of the content. Download config & data file to Flasher Prepares a connected Flasher for stand-alone mode using the current project and the data file which had focus most recently. -download Downloads configuration to emulator. Program Yes Programs the
data file. J-Flash will only use the J-Link / Flasher with the specified S/N and any operation will fail if the J-Link / Flasher with specified S/N is not connected or cannot be used for any reason. Creating a new J-Flash project The recommend way of getting started with J-Flash is to use the Create New Project wizard. Saves a .DAT file for stand-alone
mode using the name and location given. Enable J-Flash logfile If this option is checked, a file name of the J-Flash logfile can be specified. Recent Files Contains a list of the most recently open data files. The relevant data file as a .hex or .mot file (if possible) The processor and flash types used Once we received this information we will try our best to
solve the problem for you. Manual Programming > Read back > Selected Sectors Reads back the data found in the selected sectors and creates a new data file to store this information. This is useful if a target running at slow speed and the users wants to set up a PLL in the initialization sequence. Please refer to the J-Link Manual (UM08001) for
more information about the other J-Link related tools. -help Displays the help dialog. Depending on the type of action, there are either one or two textboxes next to the dropdown menu, which can be used to enter the required parameter. All bits set to 0 in “Mask” are not taken into account when comparing the Code ID found by the J-Link / Flasher
with the Core ID entered in J-Flash. @ECHO OFF REM REM :Main REM REM Function description REM Entry point for the batch script REM Starts multiple instances of J-Flash and waits until all of them have exited REM :Main REM Enable the use of variables inside the for loop by using delayed variable expansion setlocal
ENABLEDELAYEDEXPANSION REM In order to wait for all processes to finish, lock files are used which are located at %temp% set "lock=%temp%\wait!random!.lock" REM Each process blocks its corresponding lock file as long as the process is alive. What is J-Flash? For a list of all valid actions which can be used in an init sequence, please refer to
Init steps. Var Write 16bit Address (Hex) Data (Hex) Writes 16bit data of the internal variable to a given address. If command line options are provided, J-Flash will still start its GUI, but processing will start immediately. Test > Hardware > Activate OK Sets the RS232 OK signal of a connected Flasher. A custom init sequence can be created or
updated in the Init. In order to use J-Flash with an external flash device, the proper Core must be selected. .\Samples\JFlash\ProjectFiles Contains sample projects with good default settings (see section Sample Projects for further details). Sample setup In the following a small sample is given how to setup J-Flash for serial number programming. The
core ID for all listed devices is known, therefore this value is filled in automatically if a device is selected and can not be modified. Find below a table which describes the commands: Command Enabled by default? The J-Link / Flasher can either be connected to the host system of J-Flash directly via USB, Ethernet or WiFi, or it can be connected
through the J-Link Remote Server running on a remote system. Sector selection The final section of this dialog indicates the sectors to be affected by erase, read and write operations done by J-Flash. File0.bin --> Addr 0x0200 - 0x02FF Filel.bin --> Addr 0x1000 - 0x13FF Merge File0.bin & Filel.bin 0x0200 - 0x02FF Data of File0.bin 0x0300 - OxOFFF
gap (will be filled with OxFF if image is saved as *.bin file) 0x1000 - Ox13FF Data of Filel.bin Can be saved in new data file (File3.bin). Init steps Many microcontrollers require an initialization sequence for different reasons: When powered on, the PLL may not be initialized, which means the chip is very slow, or a watchdog must be disabled manually.
J-Flash requires a J-Link / Flasher as an interface to the target hardware. Output of other compilers may be supported but is not guaranteed to be. This is for example the case when the information about internal flash banks of the selected target device inside the J-Link shared library has changed from the older version of the J-Link software to the
newer version.In order for J-Flash to work properly, it is necessary for the project file information to be in sync with the information of the J-Link shared lib. J-Flash starts counting with line 0, so in order to start serial number programming with the first line of the SNList.txt, Next SN needs to be set to 0. It is able to program internal and external
flash at very high speeds, upwards of 550KBytes/s depending on the chip. This makes it possible to use J-Flash for batch processing or automatization purposes. Because of that, it is necessary for J-Flash to update the project information accordingly - otherwise it cannot open the project file. Action on J-Flash start In this section, the action J-Flash
performs on startup can be selected. The interface speed after init is used to communicate after executing the custom initialization sequence. This option is activated by default to enhance the performance. If these parameters are optional they are enclosed in square brackets too, e.g. []. CRC calculation J-Flash and Flasher are using a CRC. Save data
file as... Production settings Target power supply Available power source options are: Delay before start defines the delay (in ms) after enabling the target power supply and before starting to communicate with the target. Close project Closes a J-Flash project file. This option is activated by default. Blank check failed Meaning: The target memory was
not empty during blank check. ELF file support J-Flash has been tested with the output of the following compilers: GCC, Clang, ARM, IAR. -securechip Secures target device. The Comment text box should be used to enter a short description of the action. Var Write File 8bit Address (Hex) -- Writes 8bit data of the internal variable to a given address in
the data file. Therefore, only one J-Flash project is needed. Recent Projects Contains a list of the most recently open project files. Find below a short example of merging two data files named, File0.bin and Filel.bin into File3.bin. What is included? All gaps will be filled with 0xFF. Discharge target on disconnect causes a discharge of any capacities left
on the target on disconnect. Write File 32bit Address (Hex) Data (Hex) Writes 32bit data to a given address in the data file. MCU Settings This dialog allows the selection of microcontroller dependent settings: J-Flash can be used to program both external or internal flash memory. Please note that only one project file may be open at a time. -jlinklog
Sets a temporary J-Link logfile. Disconnect Disconnects a current connection that has been made through the J-Link / Flasher. The “Target RAM settings” define the start address and the size size of the work RAM. In general, J-Flash supports two ways of programming a serial number into the target: Programming continuous serial numbers. For
connections via the J-Link Remote Server the according connection string may be entered. Manual Programming > Verify Verifies the data found on the chip with the data file. Note: All "Write *" commands may only be used to write RAM or SFR registers, but not Flash memory. Manual Programming > Erase Chip Erases the entire chip. -savedat
Saves emulator data file. -saveas|,,] Saves the current data file in the specified file.Please note that the parameters , apply only if the data file is a *.bin file or *.c file. Creating a new init sequence Many microcontrollers require a custom init sequence to initialize the target hardware, for example to initialize the PLL, disable the watchdog or define the
wait states of the flash. Overview In addition to its graphical user interface (GUI), J-Flash supports a command line mode as well. Save project as... Var Write File 16bit Address (Hex) -- Writes 16bit data of the internal variable to a given address in the data file. Command line options This section lists and describes all available command line options.
Programming process J-Flash will increment the serial number in _Serial.txt by the value defined in Increment, after each successful programming cycle. Reference voltage settings Enabling VTref monitor causes the Flasher to monitor the target voltage (VIref) in stand- alone mode and makes the Flasher throw an error when the voltage drops below
the min- imum or rises above the maximum during programming. -> Production), those steps will be performed after verify. -eliminate Eliminates blank areas in data file. Merge data file... The polynomial which is used for the CRC calculation is 0OXEDB88320. The serial number file can also be manually edited by the user, since the serial number is
written ASCII. Shows a dialog with licensing information. Program serial number J-Flash supports programming of serial numbers into the target in two ways. See section MCU Settings for information about setting the core ID. In order to find out if special handling is necessary for the used device, please refer to the article Device specifics. The
command line options are evaluated in the order as they are passed to J-Flash, so please ensure that a project + data file have already been opened when evaluating a command line option which requires this. Sectors: Erases all sectors which are effected by the image to be programmed. For more information, please refer to Serial number settings.
Delete range... -setrxidcode Sets the RXIDCode to be used by the DLL.Additional info : 32 characters, 16 IDCode bytes -startapp Starts the target application. The option Discharge target on disconnect is for Flasher ATE only and will be ignored by the other Flasher models. In order to generate an expressive logfile, set the log level to “All messages”
(see section Global Settings for information about changing the log level in J-Flash). All important options accessible from the menus are available in command line mode as well. Serial number list file In order to program custom serial numbers which can not be covered by the standard serial number scheme provided by J-Flash (e.g. when
programming non-continuous serial numbers or having gaps between the serial numbers), a so called serial number list file needs to be created by the user. You can contact SEGGER directly via our support system: . Load most recent project Show New Project Dialog Show Welcome Dialog (default) Command Line Interface This chapter describes the
J-Flash command line interface. Exit steps Yes Executes the exit steps defined in the MCU settings Override timeouts The settings in this section are taken account for stand-alone configurations, only. For more information, please refer to Serial number settings. Troubleshooting General procedure Make sure the J-Link / Flasher is working as
expected. -connect Connects to the target. Manual Programming > Read back > Entire chip Reads back the data found on the chip and creates a new data file to store this information. Batch processing J-Flash can be used for batch processing purposes. Which devices can be programmed by J-Flash? These features along with its ability to work with
any ARM7/ARM9/ARM11, Cortex-M0/M1/M3/M4/M7, Cortex-A5/A8/A9/R4/R5 and Renesas RX600 chip makes it a great solution for most projects. Read 32bit Address (Hex) -- Reads 32bit from a given address and stores the value in the internal variable. Defining serial number address, length, start value and increment: Address is 0x08001000 Len is
4 (bytes) Next SN is 1234567 Increment is 1 Program serial number option Now J-Flash is prepared to program the 8-byte serial number. -erasechip Erases the entire flash chip. Flasher ATE module selection If this option is checked, J-Flash will connect to the selected Flasher ATE Modules. Example: Values Check result Core ID entered:
0x3BA00477Core ID found: 0x4BA00477Mask: OxFFFFFFFF Failed Core ID entered: 0x3BA00477Core ID found: 0x4BA00477Mask: OxOFFFFFFF Passed The code ID check works as follows: CoreIDFound &= Mask; CoreIDEntered &= Mask; if (CoreIDFound != CorelDEntered) { return Error; // Core ID check failed. Write&Verify 16bit Address (Hex)
Data (Hex) Writes 16bit data to a given address and verifies it afterwards. The relevant logfile and project file. -production Same as -auto -program Programs the target. Endianness The compatible endianness of the selected device is set automatically if possible. Version compatibility J-Flash is backwards compatible (as all other J-Link software),
meaning that any project files created with J-Flash version can also be opened with any version of J-Flash newer than (i.e. a project created with version V6.64 can also opened with V6.71d). Go -- -- Starts the CPU Halt -- -- Halts the CPU Reset J-Link reset type Length of the delay Resets the CPU. Disable the watchdog by writing to the Watchdog Timer
Mode Register. When this option is not set, J-Flash will open the most recently used project. Production Programming Performs a sequence of steps, which can be configured in the Production tab of the Project settings. steps tab of the Project settings menu. Device Select the respective microcontroller from the list to program internal flash devices.
Can be used to test the RS232 setup. Please refer to the Flasher documentation (UM08022) for more information regarding stand-alone mode. Programming custom serial numbers from a serial number list file. Start by selecting the Create new project option inside the Welcome dialog or by selecting File -> New project The new project wizard will
launch, which looks like as follows: Select the target device, the target interface and interface speed according to the setup. Support The following chapter provides information about how to contact our support. Eliminate blank areas... Eliminates blank regions within the data file. It provides an overview of the included sample projects and describes
J-Flash’s menu structure in detail. Getting Started This chapter presents an introduction to J-Flash. Note: Exit steps are only performed for Target -> Production Programming operations. Write&Verify 8bit Address (Hex) Data (Hex) Writes 8bit data to a given address and verifies it afterwards. Command Description Relocate... All Flasher models
come with a built-in license for J-Flash. Var XOR -- Value (Hex) Logical XOR combination of the internal variable with a given value. See the troubleshooting article: J-Link / J-Trace / Flasher Troubleshooting Ensure that the target hardware matches the project file settings. After programming the serial number, J-Flash creates the Serial.txt. See
section MCU Settings. -relocate Relocates data by the given offset. } Target RAM settings The target RAM is used during flash programming to store the RAMCode. Saves a .CFG file for stand-alone mode using the name and location given. In the simplified user interface some options are disabled to reduce possible error sources in the production
phase. SetModelLittleEndian -- -- Sets bit 7 of the CP15 register to 0. Test > Hardware > Deactivate BUSY Resets the RS232 Busy signal of a connected Flasher. are added to the serial number. Target systems The following chapter lists all supported flash devices. This should be configured for SEGGER probes connected via Ethernet directly (e.g. J-
Link PRO, Flasher PRO, ...) or using the J-Link Remote Server. J-Flash provides a dedicated menu item for unlocking flash memory. Save Flasher config file... Click OK The created Project file is now ready for use. Currently, the only operations that can be done with Flasher ATE Modules are: Download of .CFG and .DAT files User interface mode
Select the Engineering radio button when setting up a project or select the Simplified radio button when using J-Flash in production environments. Additionally, the first step executed are the init steps and the last step executed are the exit steps, which both can be configured in the MCU tab of the project settings. Write 16bit Address (Hex) Data
(Hex) Writes 16bit data to a given address. Secure chip No Secures the device if supported by algorithm. Without a license key J-Flash can still be used to open project files, read from connected devices, blank check target memory, verify data files and so on. Measured with J-Link V10 Assumptions This user manual assumes that you already possess
working knowledge of the J-Link device. No complements etc. Verification failure is handled as error and causes an abort. Set a delay of 200ms. If no serial number list file is given, J-Flash allows to use a 1-4 byte serial number. Project Settings Project settings are available from the Options menu in the main window or by using the ALT + F7
keyboard shortcut. In order to use the serial number programming feature, the J-Flash project to be used as well as some files in the working folder (depending on the configuration) need to be configured first. Sample Projects For some setups, special settings / configurations needs to be done in the J-Flash project (e.g. PLL initialization, external bus
interface initialization, script files, etc...). Set the master and processor clock by writing to the Master Clock Register of the power management controller. Remedy: Erase target memory. -programverify Programs and verify the target. Command Description Connect Creates a connection through the J-Link / Flasher using the configuration options set
in the Project settings... Verify 16bit Address (Hex) Data (Hex) Verifies whether 16bit data on a declared address is identical to the declared 16bit data. Displays the help dialog. Because of that, it is highly recommended for any user to verify the correctness of the project file settings after an auto-update by J-Flash. .hex, .mot, .srec, .bin and .elf
support. Please refer to “UM08001 Working with J-Link and J-Trace” -> “Connecting multiple J-Links / J-Traces to your PC” A J-Flash project (containing the configuration). The external flash device can be a: Parallel NOR flash Serial NOR flash NAND flash DataFlash For parallel NOR flash any combination of ARM CPU and parallel NOR flash device
(1x8bit, 2x8bit, 4x8bit, 1x16bit, 2x16bit, 1x32bit) is supported, if the NOR flash device is CFI- compliant. Option Description -? Requirements Licensing J-Flash may be installed on as many host machines as you want. Flash memory can only be influenced by altering the data file. SetAllowRemoteRead -- On/Off This option defines if the emulator
(remote) or the host handles the read access to the target. DisableMMU -- -- Disables the MMU. The interface speed before init is used to communicate with the target before and during execution of the custom initialization sequence (described in the section Init steps). Pay special attention to the following aspects: Init sequence Clock speed RAM
address Flash base address MCU / Flash chip Flash organization The interface clock frequency depends on several factors, e.g. cable length, target board etc. Remedy: Make sure the memory sector is unlocked before programming or erasing. The size of the generated data file can be defined. Disable flash bank The Disable flash bank checkbox
disables the flash bank currently selected in the dropdown menu, which can be used to change which flash banks are processed by J-Flash with only one click per flash bank. Some CPUs (e.g. TMS470R1B1M) report JTAG communication errors while initializing, so that they can not be programmed if the JTAG communication checks are enabled.
Complete data: Verifies data by reading it back. It does not log J-Flash operations performed. Serial number settings In order to use the serial number feature, the J-Flash project has to be configured to enable programming a serial number at a specific address. The J-Link logfile differs from the log window output of J-Flash. In case of verify is checked
in the production settings (Options} -> Project settings... of the Options dropdown menu. The J-Flash logfile contains the same messages as the log window output of J-Flash. Mask This option allows the user to mask out specified bits of the core ID. Merges two data files (.hex, .mot, .srec, .bin or .elf). Read 16bit Address (Hex) -- Reads 16bit from a
given address and stores the value in the internal variable. Test > Test speed Writes data of an specified size to an defined address, reads the written data back and measures the up- and download speed. Manual Programming > Program Programs the chip using the currently active data file. -setcpuidcode Sets the CPU ID code to be used by the DLL
(e.g. during authentication process). Refer to the J-Link User Manual for an detailed explanation of the different reset types. In case a serial number list file is given, J-Flash will take the serial number bytes from the list file. Note: In the process of auto-updating the J-Flash project file, some information (like the selection of sectors a flash bank) may
get reset. -readsectors Reads selected sectors. The End address must be greater than the Start address otherwise nothing will be done. For more information on how to use J-Flash for Flashers in stand-alone mode, please refer to the Flasher User Guide (chapter "Setting up Flasher for stand-alone mode "). However to actually program devices via J-
Flash and J-Link, a valid license is required. Save Flasher data file... J-Flash is a stand-alone flash programming software for PCs running Windows, Linux or macOS. Normal form: 0x04C11DB7 Reversed form: 0OxEDB88320 (used by J-Flash) Please note, that the initial CRC used for the calculation is 0x00000000 (some calculators use OxFFFFFFFF).
Write Register Register Data (Hex) Writes data into a register. Support for most external flash chips (For more information please refer to Target systems). Please note that no erase / blank check is performed prior programming so the flash is assumed to be in an erased state. Var Write 8bit Address (Hex) Data (Hex) Writes 8bit data of the internal
variable to a given address. Manual Programming > Program & Verify Programs the chip using the currently active data file and then verifies that it was written successfully. Create new project: Opens another dialog to create a new J-Flash project If “Do not show this message again.” is checked, J-Flash will execute the option currently selected
automatically on future starts without showing the welcome dialog again. Timeout errors during programming Meaning: A timeout occurs if the target is too slow during DCC communication or the target flash memory is too slow during programming. SEGGER is constantly adding support for new flash memory devices. Click the + button to open the
Add custom CPU step dialog. Target Interface Settings This dialog is used to configure the interface connection to the target: Target Interface Settings Interface Speed The interface speed used before and after initialization can be configured. Programming / Erasing failed Meaning: The flash memory sector may be locked and programming or erasing
the respective memory section fails therefore. However, if any non-ARM devices are introduced to the scan chain the IRLen must be modified accordingly. The CRC used is the CRC32-CCITT polynomial. Serial number list file needs to be specified and created by user. In general, every CFI-compliant parallel NOR flash device is supported by J-Flash. -
auto Executes the steps selected in Production Programming. Set the PLL and the divider by writing to PLL Register of the power management controller. A "simple" JTAG scan chain configuration A “detailed” JTAG scan chain configuration In a scan chain configuration with multiple devices, the TCK and TMS lines of all JTAG devices are connected,
while the TDI and TDO lines form a ring. Performance settings On "Erase selected sectors" / On "Erase chip" If Perform blank check is checked, a blank check will be performed before an erase. The latest list of supported devices can always be found on our website: List of supported devices Supported Flash Devices J-Flash supports a large number of
external parallel NOR flash devices. button. J-Flash supports programming of internal and external flash devices. Command Description Show project information Opens and/or sets the focus to the project window. Comment -- -- Can be used as additional space to insert comments. -min Starts J-Flash minimized -open[,] Opens a data file. When no data
file to open (-open) is specified in the command line, this will also automatically open the data file that has been recently used with this project. More sophisticated settings can be configured in the Project settings. Saves the data file that currently has focus using the name and location given. SEGGER is constantly adding support for new devices.
Clock speed For some devices, the actual CPU clock frequency in Hz of the MCU is required to guarantee accurate operation of J-Flash. The default device number is 0. Basically, J-Flash connects to a specific J-Link / Flasher, configured in the project settings, but there is a command line option available, which allows to temporary override this
setting. -save[,] Saves the current data file.Please note that the parameters , apply only if the data file is a *.bin file or *.c file. Manual Programming > Unsecure Chip Unsecures the MCU. Find below a small sample which shows how to program multiple targets in parallel. Example: An 8-byte serial number should be programmed at address
0x08000000. -verify Verifies the target memory. For a detailed description on how to use the serial number programming feature please refer to Serial number programming Actions performed by "Production Programming" The checked options will be performed when auto programming a target via Target -> Production Programming (shortcut: F7).
In order to program external flash, select the device or core from the list. Manual Programming > Secure Chip Secures the MCU. -jlinkdevicesxmlpath Sets the path to the JLinkDevices.xml file. Len The length of the serial number (in bytes) which should be programmed. Manual Programming > Read back > Range Reads back the data found in a
range specified by the user and creates a new data file to store this information. The example init sequence step by step: Reset the target with J-Link reset strategy 8 and 0 delay. Write JTAG IR Command -- Writes a command in the JTAG instruction register. The main window of J-Flash contains seven dropdown menus (File, Edit, Target, Options,
View, Help). Typical problems Failed to connect Meaning: This error message is shown if any error occurs during the connection process. Write 8bit Address (Hex) Data (Hex) Writes 8bit data to a given address. J-Flash and company information. For more information on the operation of J-Link / Flasher, please refer to the J-Link Manual (UM08001).
Write JTAG DR NumBits Data (Hex) Writes a declared number of bits into the JTAG data register. This is especially useful when testing different configurations. -disconnect Disconnects from the target. Notes: The option VIGT for power source is for Flasher ATE only. The serial number is always stored in little endian format in the flash memory.
Programming multiple targets in parallel In order to program multiple targets in parallel using J-Flash, the following is needed: J-Link / Flasher needs to be configured to allow to connect multiple ones to one PC at the same time. Performs jump to index on match. RAM check failed Meaning: No RAM found at the specified RAM location. Opens a data
file that may be used to flash the target device. Enable Checks -- -- Enables JTAG checks. Neither the angle nor the square brackets must be typed on the command line, they are used here only to denote (optional) parameters. The file is generated based on the serial number settings in the J-Flash project and will contain the value defined by the Next
SN option. Opens the project settings dialog. The Instruction Register length (IRLen) of a device is defined by its manufacturer. Flash Settings This dialog is used to select and configure the flash device to operate with. The serial number of a connected J-Link may be read and licenses added or removed. Please note that this is NOT the Core ID which
can be found in the MCU Settings. The following table shows the contents of all sub directories of the J-Link Software and Documentation Pack with regard to J-Flash: Directory Contents . Try setting the frequency to lower or higher values accordingly. If a project file was generated with a newer version of J-Flash where the project file format was
changed, it cannot be opened with an older version of J-Flash. Instead of that, it logs the J-Link DLL API functions called from within J-Flash.
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